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Introduction to the
Command WorkStation

This chapter introduces you to the functions and graphical user
interface of the Command WorkStation.

This chapter includes the following:

• An introduction to the Command WorkStation

• Procedures for logging in and connecting to the network

• An overview of the Command WorkStation windows and lists of
features accessed at the Command WorkStation

• An introduction to the Job Log window

• Procedures for viewing and editing job properties

For additional information about utilities and functions that can be
performed at the Command WorkStation, refer to the chapter
Managing print jobs at the Command WorkStation.
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About the Command WorkStation

The Command WorkStation provides a window on printer functions,
and an interface from which you can control those functions. The
Command WorkStation application can be installed on a Windows
95/98, Windows 2000, or a Windows NT 4.0 computer with a network
connection to the Phaser 790.

By default, no passwords are set—in this default state, anyone can
perform Setup and use all Command WorkStation functions. Until an
Administrator password is defined in setup, you can log in to the
Command WorkStation as an Administrator without entering a
password, and you are given full privileges.

After the Administrator has performed Setup and specified passwords,
Command WorkStation user options depend on your login level. Refer
to the table below for a list of which privileges are available for each
level of access.

Privilege Guest Operator Administrator

A view of current printing jobs and
jobs stored on the printer.

X X X

Control of printing jobs X X

Access to Setup, management of
resident fonts, and clearing of the
print server disk and the Job Lob

X

For information about Setup and specifying passwords, refer to the
chapter Performing the setup from the Printer Control Panel or
Performing the setup from WebSetup.

After you connect to a Phaser 790 and log in, your first view of the
Command WorkStation is the Queues window (as indicated by the tab
at the bottom), which is divided into three regions by Spool, RIP, and
Print status bars. A frame that includes slider buttons and menus
surrounds the Queues window.
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Once the Phaser 790 receives print jobs, the Queues window becomes
a dynamic display, filled with the names of jobs and their
characteristics. Status bars animate in real time as new jobs are
processed and printed, and jobs move to different display areas. An
operator, who has complete job control, sets the process in motion for
each job.

The Spool, RIP, and Print areas of the Queues window represent the
stages of printing a job. Jobs come in at the top level (Spool) and drop
down to the Print level, unless they are held along the way.
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• Spooled jobs—Jobs listed below the Spool status bar area are
PostScript or PCL files stored at the Phaser 790. These jobs were
sent to either the Print queue (white printer icons) or the Hold
queue (yellow icons).

The term PostScript is used in this manual to refer to both PostScript and
PDF data jobs. PDF is a structured form of PostScript that provides the
ability to preview, scale, and reorder pages. Where applicable, the term PDF
is specifically used to refer to PDF data or jobs.

• RIPped jobs—Jobs listed below the RIP status bar are ready to
print. They have already been rasterized (RIPped, or processed
for printing) and are waiting, in order, for access to the printer.
Rasterized jobs can also be held; held jobs are displayed on a
yellow background.

• Printed jobs—Jobs listed below the Print status bar have already
been printed. Printed jobs can be stored on the Phaser 790 disk.
The number of jobs that can be stored (from 1 to 99) is defined in
Setup.

You can interact with jobs in the window by selecting them and
choosing from Job menu commands or right-mouse menu commands,
or by double-clicking them. (However, if passwords have been set and
you log in as Guest, you can only view jobs; you cannot change or
route them.) This chapter and the next explain the Command
WorkStation interface in detail.
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Starting up and logging in

To start up the Command WorkStation application:

1. Perform one of the following:

• Select the Windows Start button and select Command
WorkStation from the Programs menu

• If you have created a shortcut to the Command WorkStation
application, double-click the Command WorkStation icon.

2. If a password is required, enter the password.

Connecting to the server

1. Perform one of the following:

• If the Command WorkStation has never been connected to a
Phaser 790, you are prompted to configure an entry for the
server. Perform the following:



16.  Introduction to the Command WorkStation

Xerox Phaser 79016–6

a. Select Add.

b. Enter the printer name in the Nickname field.

c. Select the communication type (TCP/IP, IPX, PIPE)
from the Protocol drop-down menu.

d. Enter the IP address for the printer in the Server Name
field.

e. Select the Add button.

f. Ensure that Phaser 790 is displayed in the New Device
field.

g. Select OK.

• If the Command WorkStation was previously connected to a
server, you are prompted to select a Phaser 790 from the list
of servers.

2. With the printer name (Phaser 790) highlighted, select OK. If the
device name is not displayed, select the plus sign (+) to expand
the printer entry.

The Command WorkStation connects to the server and you are
prompted to select a login level and enter a password to log in
(see the next section). If you have any difficulties connecting to
the server, refer to the Problem solving chapter for error
messages and troubleshooting information.
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Logging in

When the Command WorkStation has connected to a server, the Log
in/out slider appears, prompting you to select a login level and enter a
password. Before you log in, the Administrator key is in the vertical
position, and the Operator and Guest keys are in the flat (horizontal)
position. When you select your login level, the corresponding key turns
to the vertical position.

Perform one of the following:

• For Administrator or Operator access to the printer, select the
corresponding key, enter the password, and select Log in or
press Enter.

• For Guest access only, select the Guest key, and then select Log
in. No password is required for Guest access.

If you change your mind about logging in, or do not have the password
you need, select Cancel.

When you have entered the appropriate password and logged in, the
Log in/out slider retracts and the full Command WorkStation display
appears. The color of the key in the lock indicates your login level. If
the printer is handling a large number of jobs, it may take a few
moments to display the entire job list.

When you reopen the slider after you have logged in, the Log in button
will have changed to the Log out button.
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Access levels

The three possible levels of access to Command WorkStation
functions are Administrator, Operator, and Guest. To enable maximum
password protection, Administrator and Operator passwords must be
specified in Setup. Refer to the chapter Performing the setup from the
Printer Control Panel or Performing the setup from WebSetup.

When both Administrator and Operator passwords have been
specified, the access levels are as follows:

Access level Privileges and password requirements

Administrator Has full access to all Command WorkStation
and Printer Control Panel functions;
Administrator password required

Operator Has access to all Command WorkStation
functions, clearing the server disk, clearing the
Job Log, and font management; Operator
password required.

Guest Can view job status, but cannot make changes
to jobs or Setup, and can view the Queues
window only; no password required.

Access privileges alone do not confer control of print jobs. If the operator is
going to manage all print jobs, the administrator must route all user jobs to
the Hold queue (that is, all jobs are spooled and held on the server). To
accomplish this, only the Hold queue, and not the Direct connection or the
Print queue, should be enabled in Setup.

Logging out

Perform one of the following:

• From the Server menu, select Log out.

• Open the Log in/out slider (select the key icon just below the
Fiery logo) and select Log out.
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The Command WorkStation interface

The display illustrated below is the default Command WorkStation
display in the middle of job processing. There are two other windows,
Archive and Job Log, which you access via tabs at the bottom of the
display (3). The elements numbered 1 through 4 are common to all
Command WorkStation displays, those numbered 5 through 7 appear
only in the Queues window, and element number 8 is common to the
Queues and Archive windows.

1 Server selection tabs

2 Sliders and system information

3 Window selection tabs

4 Job ticket information

5–7 Queues window display

8 Thumbnail tabs

1
4

5

2 6

7

3

8
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The Command WorkStation provides access to a great deal of
information and many features that are accessed in various ways—
buttons, menus, double-clicking, and right-mouse commands. It is a
powerful interface that allows for a great deal of interaction and
flexibility in the production process. The following section describes
each of the elements that compose the Command WorkStation
display.

Window area (Queues, Archive, Job Log)

This area can display one of three windows: the Queues window
(shown below), the Archive window, or the Job Log window (only the
Queues window is available if you logged in as Guest). The Queues
window is the default window; it shows spooled, processing, and
printing jobs in a display that changes dynamically.

For information Refer to

Queues area Introduction to the Command WorkStation

Archive area Archiving jobs in Managing print jobs

Job Log area Introduction to the Command WorkStation
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Menu bar

The menu bar has six menus. When an action is not available in the
current context, the command is dimmed.

Menu Select this To do this

Preferences Set Command WorkStation preferences.

Print Pages Print any or all of the following pages to the Phaser
790: Configuration page, PS Test Page, Control Panel
Map, PS Font List, PCL Font List, Job Log. You can
also print the Configuration page to any printer you
specify.

File

Exit Log out from the server, exit the Command
WorkStation application, and return to the Windows
desktop.

Delete Delete one or more selected jobs.

Duplicate Duplicate one or more selected PostScript or PCL
data jobs in the Spool or Print areas.

Rename Rename a selected job.

Hold Hold the selected job(s).

RIP and Hold RIP and then hold the selected job(s).

Print Print the selected job(s).

Print and Hold Print the selected job(s) and then hold it in the RIP
area.

Process Next Give top priority to this job (Spool area only).

Remove Raster Remove the raster information from the selected
job(s).

Properties View and edit print option settings for the selected
job(s) and print job(s) with new settings.

Thumbnail A Open a selected held job in the Thumbnail A window,
where you can view a full-screen preview of the job.

Thumbnail B Open a selected job in the Thumbnail B window for
viewing a full-screen preview of the job.

Download Download files and fonts to the printer. You can also
select this command by right-clicking the Spool status
bar.

Job

Archive Archive one or more selected jobs.
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Delete

Duplicate

Preview

Page

Undo

These options are not selectable.

Cancel RIPping Stop RIPping the current job. You can also select this
command by right-clicking the RIP status bar.

Cancel Printing Stop printing the current job. You can also select this
command by right-clicking the Print status bar.

Suspend Printing Temporarily halt printing. You can also select this
command by right-clicking the Print status bar.

Resume Printing Restart printing (after a Suspend Printing command).
You can also select this command by right-clicking the
Print status bar.

Manage Fonts View the fonts currently installed on the printer,
download additional fonts, or delete fonts (requires
Administrator privileges).

Manage Color Start ColorWise Pro Tools.

Clear Job Log Clear all jobs from the Job Log (requires Administrator
privileges).

Reboot Perform a soft reboot of the printer (requires Operator
or Administrator privileges).

Clear Clear all jobs in all queues as well as all jobs archived
on the printer hard disk, the index of archived jobs,
and the Job Log (requires Administrator privileges).

Setup Start the Fiery Setup program (requires Administrator
privileges).

Server

Log out Log out of the server.

Filter Open the Filter dialog box for the active window.

Export Save the information in the active window as a
tab-delimited text file.

Print Print the active window.

View in Helper App Open the active window in a particular application you
specify.

Refresh Update the Job Log window with the latest
information.

Window

Revert to Default
Settings

Restore default settings for the status areas, the
column headings, and the column widths.

Help About View the Command WorkStation information screen.
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Server selection tabs

The Server selection tabs, just below the menu bar at the top of the
display, can be used to log in to additional servers (if your site has
more than one) and to switch between Fiery servers currently
connected to the Command WorkStation.

If you select a blank tab, you are prompted to connect to a server in
the list or configure a new server entry (refer to the section Connecting
to the server. A limit of five printers can be connected to a single
Command WorkStation.

You can access the Server selection tabs from all Command
WorkStation windows (Queues, Archive, and Job Log).

Sliders

Use the buttons along the left side of the display to activate the
function sliders.
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• Select the Fiery icon to view server information.

The Server information slider displays name and version
information about the currently connected server and the
Command WorkStation.

• Select the dial icon to open the Log in/out slider.

This slider is described in the section Logging in.

• Select the Tools icon to start a Fiery utility.

The Utilities Shortcut slider can be used to access ColorWise Pro
Tools. These utilities can also be accessed from the Job menu
and Server menu, respectively.

• Select the disk drive icon to view disk space and RAM
availability.

The System information indicators show the current availability of
RAM and hard disk space on the currently selected Fiery server,
including RAM currently in use, Total RAM, Disk space used, and
Total hard disk capacity.

To retract any slider, select the icon at the far right of the slider.
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Job ticket information

All the jobs listed by name in the Queues and Archive windows can
display the job ticket information specified by the person who
originated the print job. The Command WorkStation can display this
information because it parses the PostScript or PCL file before it is
RIPped.

You have considerable flexibility in arranging this information in the
display. For example, you can add Media Type to the display if you
want to see which jobs call for special paper or other media.

You can select not to display headers for options that are not used at
your site, or you can display all possible options and scroll to see the
ones that are less important to you. If you just want to experiment,
when you are finished you can select Revert to Default Settings from
the Window menu.

Window selection tabs

The Command WorkStation always starts out by displaying the
Queues window, from which you view current job processes and
control job flow and file storage.

To go to another window, select the corresponding tab at the bottom of
the Command WorkStation display.
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Queues window

The Queues window is a dynamic display of the job staging area. Jobs
are lined up for processing and printing. Some of them are being held
waiting for directions. Some are moving from one stage or queue to
another and are finally dropped from the list. Some are held for
processing by the operator. Finally, some are held in a different queue
in case you need to reprint them.

One approach to understanding the dynamic display is to imagine the
three parts of the Queues window corresponding to the three stages of
printing, illustrated as a downhill flow.

Spooling—a PostScript or PCL file is saved on the printer hard disk.
The file can come in packets from the network, or from another place
on the server hard disk. Jobs are added to a queue in the order in
which they arrive, and they generally move to another queue in the
same order, unless an operator intervenes to change the order.

Rasterizing (RIPping)—PostScript or PCL commands are interpreted
to allow the Phaser 790 to print the file the way its originator intended.
The result of this interpretation is a raster file associated with the
original PostScript or PCL file. In this raster file (raster image), color
data is associated with each dot that can be rendered by the print
engine. The color data tells the print engine whether or not to apply
cyan, magenta, yellow, or black dry ink to each position on the page.

Printing—transferring the raster image from the server to the print
engine at high speed, freeing up RAM for the next job. While the
PostScript or PCL file is usually saved to disk, raster images are held
in RAM during and after each print job. However, both users and
operators can request that the Phaser 790 save the raster image to
disk along with the PostScript or PCL file.

Saving the raster image to disk offers some advantages—raster files
are already processed so they print quickly, and each part of the raster
file is still identified with a page in the original document, which means
that individual pages of a saved raster file can be accessed.

Spooling

RIPping

Printing



16.  Introduction to the Command WorkStation

Xerox Phaser 790 16–17

Status bars

Jobs actively involved in the three processes (spooling, rasterizing,
and printing) are listed in the status bars that span the Queues
window.

Status bars show the filename and user name for the active process,
and an indication of its progress. Each status bar heads the list of jobs
that have completed the process. Thus, beneath the Spool status bar,
you see a list of spooled files; beneath the RIP status bar, you see a
list of rasterized (RIPped) files; beneath the Print status bar, you see a
list of jobs that have already been printed.

In the Spool status bar, the filename and user information always
appear as Unknown (as shown below). This information is not
available until the job has finished spooling to the printer.

• Spooled jobs on Hold are displayed in yellow. Active spooled
jobs are displayed in white.

• RIPped jobs on Hold are displayed in yellow. Active RIPped jobs
are displayed in white.

• Printed jobs are displayed in white. Some Print jobs include
raster data stored in RAM.

When a job is being processed, provided animation is enabled, the
corresponding status bar is animated, indicating that the process is
active.

If an error occurs, the Print status bar alerts you by displaying a
message on a red background instead of the normal blue background.
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• Enlarging the status bars

Select the small arrows at the left of the status bar to expand the
status bar display. Select the arrows again to collapse the status
bar to its original size.

To expand all the status bars at the same time, press Ctrl-E.
Select the arrows or press Ctrl-E again to collapse them to their
original size.

• Changing proportions

By default, the status bars divide the window area into three equal
parts. You can drag the RIP and Print status bars up or down to
change the proportion of the window devoted to each job area.
For example, drag the RIP status bar down if you have a long list
of spooled jobs you want to see without scrolling.

• Making space

If your workflow includes holding many jobs, and you do not want
to view the held jobs all the time, consider moving some of them
to the Archive window. You can move jobs back and forth
between the Queues window and the Archive window with a
single right-mouse command.
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Active jobs and held jobs

In the description that follows, assume the operator has full control of
jobs; that is, the administrator has disabled the Direct connection and
the Print queue, and all user jobs come to the Hold queue. For more
information about print connections, refer to the chapter, Connecting to
the network.

The operator’s job management functions permit holding a job at any
stage of the process we have described, as illustrated below. In the
figure, boxes indicate types of job icons you would see in the Queues
window.

*A copy of the held job is printed; the held job remains in the RIP area.

Jobs that are held are shown with a yellow icon in a yellow row, just
beneath the Spool or RIP status bar. Jobs that are held must be
activated with a command in order to print.

Active jobs are shown in white with white icons; new jobs are added
above older jobs

Spool

RIP

Spooled and held

RIPped and held

Print Preview and edit

Printed and held

Printed

PostScript and
PCL data

PostScript, PCL
and raster data

Deleted

Spooled for printing

Preview, edit and impose

RIPped for printing
Print*
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Job icons

Three types of icons are used for both active jobs and jobs on hold.

Icon Active Jobs
(white icons and rows)

Jobs on Hold
(yellow icons and rows)

Printer icons

PostScript, PCL, or raster data
headed for printing (top) or
after printing (bottom).

PostScript or PCL data
headed for Print and Hold or
job on Hold after printing
(Hold).

Raster icon

PostScript, PCL, and raster
data after printing, ready for
fast reprint.

PostScript or PCL data
already rasterized and held.

Spool area

The job icons in the Spool area are described below:

Icon Indicates How long you see the job

1

Yellow printer
icon and job row

PostScript or PCL data from a
user on the network; no
destination is defined.

Until a destination is chosen

2

White printer
icon and job row

PostScript or PCL data
headed for print.

3

Yellow raster icon
White job row

PostScript or PCL data
headed for RIP and Hold.

4

Yellow printer icon
White job row

PostScript or PCL data
headed for Print and Hold.

Until the RIP is free
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The Spool area is both the receiving area for jobs from users on the
network (Hold queue) and the waiting area for jobs that will be RIPped.

• Hold queue jobs—When printing requires an operator (because
the Print queue and Direct connection are disabled), the operator
must assign a destination to all jobs received from users on the
network (icon 1 in the table above). Once assigned, jobs (icons 2,
3, and 4) move down the Spool queue for processing. All jobs
printed to the Hold queue require routing by an operator. The
Hold queue also enables you to use all workflow features of the
Command WorkStation with PDF files.

• Print queue jobs—When printing does not require an operator,
network jobs sent to the Print queue appear in the Spool area,
where they are shown with a white printer icon (icon 2). When
they reach the head of the queue, they are RIPped and printed
without operator intervention.

• Direct connection jobs—Jobs printed to the Direct connection are
not displayed in the Command WorkStation job lists. They are
displayed briefly in the status bars (where they cannot be
selected) and are included in the Job Log.



16.  Introduction to the Command WorkStation

Xerox Phaser 79016–22

RIP area

The job icons in the RIP area are described below:

Icon Indicates How long you see the job

1

Yellow raster
icon and job row

Raster data; no destination
defined; may have been
printer before and held.

Until it is deleted, moved to
the Archive, or stripped of its
raster data and sent to the
Spool area

2

White printer
icon and job row

Raster data headed for print in
its turn; no hold defined.

Until the printer is free to
print the job

After a job is rasterized, it goes into the RIP area. The RIP area holds
only raster data (i.e., jobs that have been rasterized). Jobs in the RIP
area are either waiting for the printer to be free (Print queue jobs, icon
2 in the above table), or they are being held. Held jobs in the RIP area
have already been rasterized (RIP and Hold) or they have been printed
and their raster data has been routed back to the RIP area (Print and
Hold), where they are shown in yellow rows (icon 1).

Raster jobs in the RIP area that are waiting to print (icon 2 in the table
above) cannot be manipulated by job commands.

Jobs held in the RIP area remain there until the operator moves them
to the Archive window or deletes them. Printing these jobs does not
remove them from the RIP area. Instead, a copy of the job is created
and printed.

For all rasterized jobs, the print option settings, in addition to the current
calibration state of the printer, remain with the saved raster data each time
the job is reprinted. To print the job with new print option settings and with
new calibration data, you must remove the raster data and reRIP the job.
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Print area

The job icons in the Print area are described below:

Icon Indicates How long you see the job

1

White printer
icon and job row

PostScript or PCL data only—
raster data has been deleted

Until the job limit is reached

2

White raster
icon and job row

Raster, PostScript and PCL
data

If RAM is needed to RIP an
active job, the raster data is
deleted and the job is assigned
the PS icon (in row 1)

Until the job is reprinted or
the job limit is reached

The Print area, also referred to as the Printed queue, contains jobs that
have already been printed. These jobs were assigned the Print
destination (white printer icon in the Spool or RIP areas) without any
Hold instructions; therefore, they all have white icons and rows.

A job row that appears in light red indicates that an error occurred while
printing the job. To see the error, double-click anywhere in the row.

Newly printed jobs are added to the Printed queue, and are shown at
the top of the list. Jobs are saved in the Printed queue until the job limit
is reached. When the first job over the limit is printed, the oldest job is
deleted from the disk. The default job limit is 10 jobs. The value for
Jobs Saved in Printed Queue can be changed in Setup by the
administrator.

If you reprint a job in the Printed queue, the job returns to its original position
in the Printed queue after it is printed.

While it is printing, a job consists of PostScript or PCL and raster data.
The raster data in RAM is not cleared until memory is needed to
rasterize the next job. As long as the raster data is intact, the job can
be reprinted from the Printed queue. Printed jobs that still have their
raster data are represented by a white raster icon in the Printed queue
(icon 2 in the previous table); jobs with only PostScript or PCL data
remaining are represented by a white PS icon (icon 1). If the job was
printed from a held raster job (in the RIP area), the raster data in the
RIP area remains and can be used to reprint the job after the raster
data has been cleared from the Printed queue.
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Job commands

Job commands are used to assign a selected job to a new destination
or process. These commands are available from the Job menu. Many
are also available as right-mouse commands (described following the
list of commands below). The job commands available at a given time
depend on the context; unavailable commands are dimmed. Job
commands are available in the Queues and Archive windows.

How job commands affect raster data

The job commands available for selected jobs in the Queues and
Archive windows are listed in the following table. The table also
describes the effect of each command on raster data associated with
the job(s).

Select To do Raster data is…

Delete Delete the job(s). Deleted

Duplicate Duplicate one or more selected PostScript,
PCL, or PDF data jobs in the Spool or Print
areas. You can use the duplicate job(s) for
different print options or a different
destination. (The Duplicate command
actually creates a reference to the original
job, with the same name).

n/a
(The Duplicate command
is not available for raster
jobs.)

Rename Rename the job (PostScript, PCL, or PDF file
with or without raster).

Unaffected, but associated
with the new name

Hold Hold the job in the current place (except for a
job in the Print area, which is moved to the
Spool or RIP area, depending on whether it
still has raster data associated with it).

Held in RIP area, if
included with job

RIP and Hold RIP the job and hold it in the RIP area. Held in RIP area
indefinitely

Print Print the job in its turn (RIP it first if it does
not have raster data).

After printing, keep the printed job in the Print
area until the job limit is reached.

Temporarily held in RAM
after printing until memory
is needed for another job.
(If the job was printed from
a held job in the RIP area,
the raster data in the RIP
area is kept indefinitely.)
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Print and Hold

(Like the user print
option Save Fast
Reprint)

Print the job in its turn (RIP it first if it does
not have raster data)

After printing, hold the PostScript data and
the raster in the RIP area.

Held in RIP area
indefinitely (saved to disk)

Process Next Give top priority to this job.

RIP (and then print) it as soon as the
processor is free, before other waiting jobs.

Option is dimmed if there are no other
waiting jobs.

n/a

This command is available
only for jobs in the Spool
area that are not currently
held.

Remove Raster Remove the raster data from a job that has
raster data (indicated by a raster icon); leave
the PostScript data unaffected.

Deleted

If you remove raster from a
job in the RIP area, the job
is sent to the Spool area.

Properties View, override print option settings, and print
a selected job or a group of selected jobs.

Possibly deleted and
regenerated, depending on
whether you change any
settings that require re-
RIPping.

Thumbnail A Open a selected held job in the Thumbnail A
window where you can view a full-screen
preview of the job.

Unchanged

Thumbnail B Open a selected job in the Thumbnail B
window for viewing.

Unchanged

Download Download files and fonts to the printer with
WebTools. Refer to the chapter Using the
Fiery WebTools.

n/a

Archive Archive the selected held job(s) to the printer
hard disk, the internal ZIP drive, the local
Command WorkStation hard disk, or to a
device on the network and move the job icon
to the Archive window.

Archived with the job, if
archiving of raster data is
specified
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Using right-mouse commands

Use the following instructions to activate job commands with a single
right-mouse click.

1. To route a single job in the job list, right-click the job.

2. Select one of the commands or destinations and release the
mouse button.

The command is carried out or the job is routed to the destination
you chose. Depending on your choice, the job line may reappear
in a different part of the window or a different window, or the job
line may be deleted.

3. To route multiple jobs at the same time, select the jobs first.
Select the first job line. Shift-click to select adjacent jobs.
Ctrl-click to select nonadjacent jobs.

Select jobs with the same job icon; otherwise, the destination
options may not be the same. For example, select multiple jobs in
the Spool area, and select Print.

4. With the cursor still in one of the selected job lines, press the right
mouse button.

5. Select one of the commands or destinations and release the
mouse button.

The command is carried out or the jobs are routed to the
destination you chose.
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Archive window

If you want to store jobs before or after printing them, you can archive
them. The printer can archive jobs internally (on the printer hard disk)
and externally, on the Command WorkStation hard drive, the ZIP disk,
or on network drives. For instructions on how to archive jobs, refer to
the chapter Managing print jobs at the Command WorkStation.

The Archive window is not available if you logged in as Guest.

PostScript and raster data jobs can be archived, but jobs must first be
held in the Spool or RIP areas of the Queues window before they can
be archived.

When you archive a job, the job is moved, not copied, to the archive
destination (the archive area or the external device). The Archive
window shows a cumulative list of all jobs that have been archived.
This list is cleared (along with all jobs on the server) by selecting Clear
Server on the Printer Control Panel or by using the Clear command
from the Command WorkStation.

The job icons in the Archive window are described below:

Icon Indicates

Printer icon

PostScript or PCL data only—raster data
not present or deleted

Job was archived from the Spool area

Raster icon

Raster, PostScript and PCL data

Job was archived from the RIP area

The job commands can also be used with jobs in the Archive window.
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The icons that appear in the Archive window are always white, since
they have no destination (as long as they are in the Archive window).

By default, the Archive window displays all archived jobs. Until they are
deleted, archived jobs remain in the Archive window indefinitely. You
can display a subset of archived jobs based on various selection
criteria by using the Filter command.

1. Select the Window menu and the Filter option.

2. Enter the desired selection criteria in the Filter dialog box.

For more detailed information, refer to the section Filtering jobs.

As with the Queues window, you can select the headings for the
display and use Job menu or right-mouse commands; you can also
sort jobs.
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To: Do this:

Sort jobs in a category, such as by
Date

Double-click the Date/Time heading. A small arrow
indicates whether jobs are sorted in ascending or
descending order. Double-click again to sort in the
reverse order.

Route a job to a destination in the
Queues window

Use job commands from the Job menu or the
right-mouse command menu. For example, to print a
job, select Print or Print and Hold. You can also select
and route multiple jobs.

The other options, RIP and Hold or Hold, send a copy of
the job to the Queues window (to the RIP and Spool
areas, respectively, without printing it. Remove Raster,
which applies only to jobs with the raster icon, leaves
only the PostScript data for the job in the Archive
window.

View only particular jobs Select Filter from the Window menu and make entries
in the Filter dialog box.

Delete a job Select the job(s) and Delete from the Job menu or
right-mouse command menu.

Display or move job ticket
information headers in the Archive
window

Right-click on the appropriate column head; select Add
from the drop-down menu to list the columns that you
can add to the display. The categories are the same as
in the Queues window, but you can arrange them
differently. The column head arrangements you set in
the Archive window are independent of those you set in
the Queues window.

Adjust the width of a column Select the column border in the heading and drag left or
right.

Export the currently displayed list of
archived jobs to a tab-delimited text
file

Select Export from the Window menu. Specify a
filename (the default name is archive.log) and a
location for the file and select Save. You can then open
the exported file with a spreadsheet, database, or word
processing application.
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Job Log window

The Job Log is a list of processed and printed jobs, the date and time
they were processed or printed, and the characteristics of the job. It
includes downloaded files and fonts and RIP and Hold jobs.

The Job Log window is not available if you logged in as Guest.

At any given time, the Job Log includes only those jobs processed or
printed since the Job Log was last cleared. The Job Log can be
cleared manually by selecting Clear Job Log from the Server menu or
automatically if the administrator has enabled autoclearing of the Job
Log in Setup. The Job Log is also cleared by selecting Clear Server
on the Printer Control Panel or by selecting the Clear command from
the Command WorkStation.

You can adjust the column widths in the Job Log display by selecting
the column border in the heading and dragging left or right. For more
information, refer to the chapter Managing print jobs at the Command
WorkStation.

When you open the Job Log, you can select to display all jobs in the
current Job Log or only the jobs in a specified date range. By default,
all jobs are displayed.
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To specify a date range:

1. Select the Window menu and the Filter option.

2. Select the Range radio button, and enter dates in the From and
To fields.

For more detailed information, refer to the section Filtering jobs.

In the Job Log, Start Time reflects the time that the job began RIPping; End
Time reflects the time that the job printed; and Process Time reflects the
total RIP time for the job. These times do not correspond to the Date/Time
values displayed in the Queues window.

• Updating the Job Log display—To update the Job Log
window display after specifying a date range (or at any other
time), select Refresh from the Window menu.

• Exporting the Job Log—From the Job Log window, you
can export the Job Log to a tab-delimited text file (the default
name is job.log) by selecting Export from the Window menu.
The exported file can be opened with a spreadsheet,
database, or word processing application. The exported Job
Log contains the jobs for the date range you specified.

• Clearing the Job Log—The Job Log is stored on the server
disk. When logged in as Administrator, you can clear the Job
Log by selecting Clear Job Log from the Server menu. The
Job Log is cleared whenever an Administrator clears the
server or installs new software. In addition, the Job Log can
be cleared automatically after every 55 jobs.
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• Printing the Job Log—To print the Job Log, select Print
Pages from the File menu, select Job Log, Print, and OK.
The Job Log is sent to the Print queue and then prints to the
Phaser 790. You can use Job menu commands to
manipulate the Job Log print job as you would any other job.
The printed Job Log contains the jobs for the date range you
specified. Refer to the section Using the Job Log in the
chapter Managing jobs at the Command WorkStation for
more information.

• Printing and clearing the Job Log automatically—You
can decide how you want to handle the Job Log. If you have
Administrator privileges, you can select Setup from the
Server menu and enter your preferences in the Job Log
Setup. You can specify whether to print the Job Log
automatically every 55 jobs, or both print and clear the Job
Log automatically every 55 jobs. You can also select the Job
Log page size.
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Filtering jobs

The Queues, Archive, and Job Log windows display a cumulative list of
all jobs. If a large number of jobs are listed, it may be difficult to locate
a particular job or a particular group of jobs. You can display a
specified subset of jobs by filtering jobs in the Queues, Archive, and
Job Log windows.

To open the Filter dialog box, select Filter from the Window menu.

In the Queues window you can filter jobs according to any or all of the
following criteria:

• Job title

• User name

• Date created (or a date range)

• Device

In the Archive window, you can filter jobs according to any or all of the
following criteria:

• Job title

• User name

• Date created (or a date range)

• Device

In the Job Log window, you can filter jobs by date only.
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The Filter command lets you perform a search based on any and all
values you specify in the Filter dialog box. Enter values in all fields
relevant to your filtering criteria. If you enter values in more than one
field, only jobs that meet all the criteria are displayed. For example, if
you enter 10 in the Job Title field and <UserName> in the User field,
only those jobs whose titles somewhere contain 10 and whose User
name somewhere contains <UserName> will be displayed.

To filter by date, select Range in the Date created area and enter
dates in the From and To fields; or, select the arrows next to the From
and To fields and select dates by selecting them in the calendar that
appears. Select the arrows at the upper corners of the calendar to
display different months. The range of dates available for filtering is
01/01/1980 to 12/31/2099.
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Creating Filter templates

If you often filter jobs according to specific criteria, you can create a
filter template. In this way, you can filter jobs easily in one step and
avoid the need to enter specific information each time you want to filter
jobs.

1. Open the Filter dialog box by selecting Filter from the Window
menu.

2. Enter specific job filter criteria in the appropriate fields.

3. Select Save As.

4. Enter a name for the new template and select OK.

The new template is saved in the Templates drop-down list in the
Filter dialog box.

Viewing Filter templates

You can view jobs in the Queues, Archive, and Job Log windows
according to a filter template.

1. Open the Filter dialog box.

2. Select the template by name from the Templates drop-down list
and select OK.

Deleting Filter templates

1. Open the Filter dialog box.

2. Select the template by name from the Templates drop-down list,
and select Delete.

3. Select OK to confirm the deletion.
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Job properties

When logged in as Operator or Administrator at the Command
WorkStation, use the Properties command to check and override the
print option settings (properties) of most jobs.

You cannot override the print option settings of PCL jobs.

You can use this command for several purposes:

• To check user job settings

• To override a setting based on printed output or other print device
conditions

• To change settings for a duplicate of the original job

• To print a single copy of a job before printing the number of
copies required by the user

Viewing and editing job properties

The Properties command lets you view, edit the print option settings of,
and print multiple jobs simultaneously. You can use this feature to
compare the properties of several jobs and thereby group together jobs
with similar settings, if it is beneficial for throughput or efficiency.

To view the properties of one or more jobs, select the job(s) and select
Properties from the Job menu or the right-mouse menu.

For information on using the Properties dialog box to change job
settings, refer to the section Viewing and overriding print settings in the
chapter Managing print jobs at the Command WorkStation.

Some print options that are available in the printer driver are not
displayed in the Properties dialog box. For information on specific print
options and settings, and where they can be set, refer to the chapter
Print options.
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